
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Magnetek Material Handling 
 IMPULSE®• LINK 4.1 Basic 

 
 
 

Instruction Manual  
 
 
 
 
 
 
 
 
 
 

 
 

 
 February 2006

Part Number: 140-10350
©Copyright 2006 Magnetek Material Handling



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

©2005 MAGNETEK MATERIAL HANDLING 
All rights reserved. This notice applies to all copyrighted materials included with this product, including, but not limited 
to, this manual and software embodied within the product. This manual is intended for the sole use of the persons to 
whom it is provided, and any unauthorized distribution of the manual or dispersal of its contents is strictly forbidden. This 
manual may not be reproduced in whole or in part by any means, whatsoever, without the expressed written permission of 
MAGNETEK. 
 
IMPULSE• LINK 4.1 Basic Software is Copyrighted by Magnetek. All rights reserved. 
 



IMPULSE•LINK 4.1 Basic Instruction Manual—2/01/2006 

1 

 
Table of Contents 
 
Warning, Caution and Notice      p.2 
 
Chapter 1 – Introduction       p.3 

Overview        p.3 
System Requirements       p.3 
 

Chapter 2 – Installation       p.4 
Software Installation       p.4 
Connecting to your PC       p.5 
Creating Communication Profiles Using the Wizard   p.5–6 
Getting Started        p.7 
 

Chapter 3 – Navigation       p.8–10  
   
Chapter 4 – Parameter Maintenance     p.11 
 Read From VFD       p.11  
 Write To VFD        p.11 
 Modifying Parameters       p.12 
 Parameter File Comparison      p.13 
 Security / Password Protection      p.13 
 
Chapter 5 – Monitoring       p.14 
 Monitor        p.14 

Fault Reset        p.14 
 
Chapter 6 – Additional Menu Features     p.15 
 Print Preview & Print       p.15 
 Parameter File Conversion      p.16 
 Viewing Parameters–Keypad Simulator     p.17 
 Copy & Paste        p.17 
  
Chapter 7 – Troubleshooting      p.18 
 Drive Fault References       p.18 
 Communication Error References     p.19 
 Communication Profile Test      p.20 
 Show Error Log        p.20 
 
 
 
 
 
 
 
 
 
 
 
 



IMPULSE•LINK 4.1 Basic Instruction Manual—2/01/2006 

2 

Warning and Caution 
 
DISCLAIMER OF WARRANTY 
 

Magnetek’s Electromotive Systems, hereafter referred to as Company, assumes no responsibility for improper 
programming of a drive that resulted from use of this software. This software should only be used by a trained 
technician who has read and understands the contents of this manual. Normal use of this software may result in 
the drive parameters becoming modified. Improper programming of a drive can lead to unexpected, undesirable, 
or unsafe operation or performance of the drive. This may result in damage to equipment or personal injury. 
Company shall not be liable for economic loss, property damage, or other consequential damages or physical 
injury sustained by the purchaser or by any third party as a result of the use of this software. Company neither 
assumes nor authorizes any other person to assume for Company any other liability in connection with the sale 
or use of this software. 

 

 
1. Read this user manual in its entirety before installing IMPULSE®• LINK 4.1 Basic Software or operating the 

IMPULSE®• G+/VG+ Series 2, IMPULSE®• G+/VG+ Series 3 , and/or IMPULSE®• P3 Series 2 Variable 
Frequency Drives (VFD). 

2. DO NOT connect or disconnect wiring, or perform signal checks while the electrical power is turned ON. 
3. Improper programming of a drive through the use of this software can lead to unexpected, undesirable, or unsafe 

operation or performance of the drive. 
 

Failure to observe these and other precautions indicated in this manual will expose the user to high voltages, resulting 
in serious injury or death. Damage to equipment may also occur. 
 

 

 

 
 
NOTICE 
No patent liability is assumed with respect to the use of the information contained herein. Moreover, Magnetek is 
constantly improving its high quality product therefore, the information contained in this manual is subject to change 
without notice. Every precaution has been taken in the preparation of this document. Nevertheless, Magnetek assumes no 
responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the 
information contained in this publication. 
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Chapter 1 -  Introduction 
 
OVERVIE W  
 
IMPULSE• LINK 4.1 Basic is a user-friendly, Windows® based, interactive drive communication software. It is designed 
specifically for communication between Magnetek’s IMPULSE• G+/VG+ Series 2, IMPULSE• G+/VG+ Series 3, 
IMPULSE• P3 Series 2 drives and your PC with the supplied cable. The IMPULSE• Link 4.1 Basic Software allows you to 
upload/download parameters, program and monitor your IMPULSE drives. 
 
 
The IMPULSE• LINK 4.1 Basic Kit (Part #157-10028) contains the following components: 
 

1. CD containing IMPULSE• Link 4.1 Basic Software  
  
2. Cable for IMPULSE• G+/VG+ Series 2 

 
3. Cable for IMPULSE• P3 Series 2 or IMPULSE• G+/VG+ Series 3 drives 

 
4. USB to serial converter 

 
 
 
SYSTEM REQUIREMENTS 
 
Supported Drives  
IMPULSE• LINK 4.1 Basic supports the IMPULSE• P3 Series 2, IMPULSE• G+/VG+ Series 2 and Series 3 drives.   
 
 
Supported Communication 
 
IMPULSE• Link 4.1 Basic supports the following types of communication: 

Serial 
RS232 *1 RS485 *2 

 

Availability Protocol Availability Protocol 
IMPULSE• G+ Series 2 
IMPULSE• VG+ Series 2 

Built in Modbus RTU Option Card 
(140-10261) 

Modbus RTU 

IMPULSE• G+ Series 3 
IMPULSE• VG+ Series 3 

Built in Modbus RTU Built in Modbus RTU 

IMPULSE• P3 Series 2 Built in Modbus RTU Built in Modbus RTU 
*1—USB to Serial converters are available if an RS232 serial port is not found on your PC. 
*2—A USB to RS485 converter, an RS232 to RS485 converter or an RS485 card is required for your PC. 

 
 
PC Requirements 

1. Pentium class or equivalent 500MHz processor or better 
2. 256 MB RAM or better 
3. Minimum of 100 MB free hard-disk space available 
4. Windows 98 SE operating system or better 
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Chapter 2 -  Installation  

SOFTWARE INSTALLATION  
The IMPULSE•LINK 4.1 Basic comes with a CD containing the IMPULSE• LINK 4.1 Basic Software and, Adobe 
Acrobat Reader™ for this technical manual.  

 • To run the IMPULSE• LINK 4.1 Basic Setup, put the IMPULSE• LINK 4.1 Basic CD into your CD drive. Run 
setup.exe from the CD if it does not start automatically. 

 
 • Select the default choices during installation.  

 
 

Free Updates, Patches 
Additional features and bug fixes may be available from time to time. These may be downloaded from the Magnetek 
Material Handling website at www.magnetekmh.com/mg_support_downloads-software.htm. 
 
Software Removal 
To remove the IMPULSE• LINK 4.1 Basic Drive Interface Software, open the Control Panel’s Add/Remove Programs 
dialog box, double-click the IMPULSE• LINK 4.1 Basic entry and choose Remove All from the IMPULSE• LINK 4.1 
Basic Setup dialog box. 
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CONNECTING TO YOUR PC 
Use the appropriate cable provided in your IMPULSE• LINK 4.l Basic kit to connect your PC to the drive. 
 
For IMPULSE• G+/VG+ Series 2 drives: 

1. With power off, remove the keypad from the front corner of the drive 
2. Connect the female connector into the drive’s keypad receptacle 
3. Attach the DB-9 connector end of the cable to the serial communication port on the PC 

For IMPULSE• P3 Series 2 and IMPULSE• G+/VG+ Series 3 drives: 
1. With the power off, remove the keypad 
2. Connect the RJ45 plug into the drive’s keypad receptacle 
3. Attach the DB-9 connector end of the cable to the serial communication port on the PC. 

 
 
 

CREATING COMMUNICATION PROFILES USING THE WIZARD 

The communication profile consists of the settings available to establish communication to the IMPULSE drives. There is 
a wizard available to assist you setting up the communication profile.  In the Settings Menu, click “Communication”, and 
then “New”.  You will then see the following screen appear: 
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Highlight the IMPULSE drive RS-232 for the communication through the keypad port, and then click “Select”.  The 
wizard will then take you through the following three steps to set up a new communication profile. 

 Step 1:  Name, Description, Crane and Motion 
 Step 2:  Common Port, Protocol, Slave Address, 

Baud Rate, Parity 
 Step 3:  Finish 
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GETTING STARTED 
Run IMPULSE•LINK 4.1 Basic by clicking on the “L” icon found on your desktop. A splash screen will appear for a few 
seconds while the subsystem loads. 
 

 
 
 
Select the profile that you created in the drop down profile box as shown here, and you are ready to access your 
IMPULSE drive. 
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Chapter 3 -  Navigation 
The IMPULSE•LINK 4.1 Basic Software is a Windows-based software with easy to use menus and drop-down functions.  
The user is able to access utilities for uploading/downloading parameters, comparing parameters, saving parameters to a 
file, and more from the easy to navigate toolbar.  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

New – Displays the controller properties dialog to create a new 
factory default parameter set, based on the drive type, software 
number, model, and kVA. 
Open – Opens or finds a file containing a parameter set for a 
specific drive type and software number. 
Save –  Saves the active file with its current file name and 
location. 
Save As –  Saves the active file with a different file name or 
location. 
Print Preview –  Shows how a file will look when you print it. 
Prin t –  Prints the active parameter set. Select Print options, in the 
Print window/dialog box. 
Properties –  Displays the properties box to view the properties of 
the active file. 
Exit – Closes this program after prompting you to save any 
unsaved files. 

Communication –Allows communication profiles to be added,
removed, edited, copied, imported and exported. 
Preferences – IMPULSE• LINK 4.1 Basic settings for access level.
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Write Flash - Allows a binary file to be written to VFD flash
memory. (FACTORY USE ONLY) 
Read from VFD - Loads all parameter values from the VFD to
memory. 
Write to VFD - Saves all parameter values from memory to the
VFD. 
 

Convert – Allows for parameter files to be converted from
one software/Flash ID to another (must be within the same
series). 
Compare Parameters - Allows for comparison of sets of
parameter files. 
Communication Test – performs a communication test with
the VFD. 
Monitor – Displays a select number of monitor parameters
(U-parameters), updated continuously. 
Keypad Simulator – Emulates the keypad and allows for
navigating the keypad menu remotely.  
Show Error Log – shows the status of IMPULSE• LINK 4.1
Basic. 
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Window - Allows for easy parameter window organization when in
multiple window mode.  The functions in the Window menu such as:
Cascade, Tile Horizontally and Vertically, Minimize All, and Close
All, function just as they do in other Microsoft Windows-based
applications. 

Users Manual – Displays the User Manual. (Acrobat Reader must
be installed) 
IMPULSE LINK Help – Provides information on communication
profile settings and troubleshooting, complete Index of VFD fault
codes, and a Search function. 
Electromotive on the Web – provides a link to the Magnetek
Material Handling website. 
Check for Updates – provides a link to the download software
page of the website that offers updates. 
About - Displays the version number of this Electromotive
Systems product, copyright and legal notices. 
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Chapter 4 -  Parameter Maintenance 
 
IMPULSE• LINK 4.1 Basic software provides flexibility in programming, uploading, downloading, and saving 
parameters. With full parameter descriptions and visual programming, modifying parameters from your computer has 
never been easier. 
 
Read from the VFD - allows you to load the parameter values from the drive’s memory.  This can be accomplished 
through the ‘VFD’ drop down menu or the ‘Read’ Icon (as shown below).     

 
 
 
 
Write to VFD - saves all parameter values from memory to the VFD.  Again, this can be accomplished via the drop down 
on the ‘VFD’ menu or using the ‘Write’ Icon as shown here. Writing to VFD may result in undesirable operation of your 
crane, causing danger, personal injury or death! To proceed with the write to VFD function you will need to accept that 
you acknowledge the warning message as shown here. Once you have checked the ‘I Accept’ button, the ‘Continue write 
to VFD’ button will be available. 
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Modified Constant 
A parameter with blue text implies that its value is different than its default setting.  
- This list should match the modified constants list in the drive, with the exception of A1 parameters.  
 
Read-Only 
A grayed-out, highlighted parameter implies that it cannot be modified. This can happen for the following 
reason. 
- The Access Level of the current parameter set is lower than what is needed for this specific parameter (i.e. 

Changing this parameter from the drive keypad would not be allowed with the current access level.) 
 
Over Maximum / Under Minimum 
A parameter with red text implies that its value is either greater than its maximum value or less than its minimum. 
An invalid value in the FIF file could result in this error. 

 
MODIFYING PARAMETERS 
By double clicking on the row of the parameter you would like to edit, the setting column will appear as a drop-down box, 
a text box, or a visual programming window. 

1.  Drop-down list box of parameter setting choices 
 

List box 

 
 

This will appear for list parameters. Simply select the value from the list and: 
- ENTER to accept the change 

- ESC to cancel the change 
 

2.  Text box for entering a parameter value 
 

Text box 

 
 

This will appear for numerical parameters.  
Simply type in the value of the parameter (in the base displayed) and: 

- ENTER to accept the change 
- ESC to cancel the change 

 
3.  Visual Programming Window (click once on the visual programming icon) 
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PARAM ETER FILE COMPARISON 
The Parameter File Comparison function found in 
the Tools drop-down menu allows for comparison 
of sets of parameter files. 
 
The “Show” drop-down allows you to compare: 

- all parameters of each file,  
- only parameters with different values,  
- or only parameters with equal values. 

 
 
 
 
 
 
 
 
 
 
 
 
 
SECURITY / PASSWORD PROTECTION  
The ‘Preferences’ drop-down menu in IMPULSE• LINK 4.1 
Basic software allows you to set the access level, username 
and password.  
 
By logging out of the Advanced mode you will be in the User 
mode. While in the User mode, the drives can only be 
monitored. Write to VFD and Reset functions are NOT 
available.  

 
 
 
 
 

This Visual Programming Window will pop-up for hexadecimal and binary parameter values.  The window 
provides the actual parameter value description, so that you won’t need to use the technical manual to translate a 
hexadecimal or binary value. Simply click the mouse on the table to modify, and then click on the “OK” box or hit 
enter to accept the change. Click the “Cancel” box or ESC to cancel the change. 
 
NOTES: 

1. If a change is made, ENTER is not pressed to accept it, and the user clicks on another row or column, the 
value will revert back to what it was before the change. 

2. If a parameter is changed to an invalid value, under the minimum value or over the maximum value, an 
appropriate message will be displayed and the value being edited will revert back to what it was before the 
change. 
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Chapter 5 -  Monitor/Function 
 
MONITOR  
 
 
  
 
 
 
 
 
 
 
 
. 
 
 
 
 
 
 
 
 
 
You can reset a fault in the Monitor window as long as the drive doesn’t have a 
Run command and the fault condition no longer exists.  Once you click on 
the fault reset icon, a warning message will prompt you to accept that 
you acknowledge the warning. When resetting a drive remotely, you need 
to be sure that all personnel and/or operators are notified.  Once you have 
checked the “I accept” box, the “Continue Fault Reset” button will be available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There is a 
‘Monitor’ function 
in the ‘Tools’ 
drop–down, which 
displays a select 
number of monitor 
parameters (U-
parameters) that 
are continually 
updated. 

Fault Icon 

Fault Reset Icon 

FAULT RESET 
In the event of a 
fault condition, you 
will see the fault 
icon on the Monitor 
window, as shown 
here. 
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Chapter 6 -  Additional Menu Features 

PRINT PREVIEW 
IMPULSE• LINK 4.1 Basic provides a compact printing mode that displays all drive parameters in only 1-2 pages. It also 
prints a more detailed mode that lists descriptions as well as units for each parameter. 
 
Compact Parameter Print Preview 

 
 
 
 
 
 
 

Print 

 
 
NOTE: Only parameters that are viewable in the  
Parameters Window will be printed. 
 
 

Detailed Parameter Print Preview 

Print Name – Allows the user to select from any printer installed on
his/her system. The user’s default printer is initially selected. 
Print Mode - Allows the user to choose the printing style.  
o Compact mode (1-2 pages) provides parameter names and

setting values.  
o Detailed mode provides parameters, descriptions, setting values,

units, as well  ‘modified’ information. 
o As shown prints all of the information as shown on the screen. 
OK Button – Prints the active parameter set to the selected printer in
the chosen format.  
Cancel – Closes this dialog box without printing. Changes to
Customer Name, Application and Job Number are not saved. 
 
Text placed in the Customer Name, Application and Job Number
fields appear on the printout. 
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PARAMETER FILE CONVERSION   
‘Convert’ under the ‘Tools’ menu allows for parameter files to be converted from one software/Flash ID version to 
another (within the same drive series).  

 
 

 
 

 
 
 
 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Digital Operator Emulator NOTES:  
 

1. To Activate, Select the correct drive profile from the dropdown and 
click the w button. 

2. The RUN command has been disabled for safety reasons. 
3. If the drive is put into “Program Mode” and not returned to “Run 

Mode”, the user will be unable to run the drive. 
 

Source – Specifies the file to be converted. 
 
Flash ID – Specifies the software type that the 
file will be converted to. 
 
Destination Filename – Specifies the 
Destination filename.  
 
Convert - Converts the parameter file specified in 
“Source” to the format specified in the software 
version in the Flash ID. The converted file is 
saved to the filename and path specified in 
“Destination Filename”. 

Keypad Simulator – The keypad simulator emulates the 
IMPULSE• P3 Series 2 or IMPULSE Series 2 or 3 keypad, which 
allows for remote keypad menu navigation. This function is 
available when connected via the drive’s keypad connector (not 
with RS485 connection). If you attempt to run the keypad simulator 
while connected via the RS485 connection a CF00 Comm Error 
will occur.
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VIEWING PARAMETERS 
The ‘View’ drop-down box allows you to select how the parameters are viewed, as shown below   
(all, modified, or another sub group).  
 

 
 
 
 
 
 
 
 
 
 
Copy & Paste-   
The copy & paste function works just like a 
Microsoft Windows application. You can 
highlight multiple rows and/or columns using 
either the ‘shift’ key or your mouse and then 
right click to either copy or print that 
highlighted area.  If you selected ‘copy’ 
when the area is highlighted, you can then 
open another Windows application and paste. 
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Chapter 7 -  Troubleshooting 
 
In the Troubleshooting section of 
the IMPULSE• LINK 4.1 Basic Help 
Menu, you can select either Drive 
Fault References or Error 
References. The Drive Fault 
References provide the fault code, 
description and corrective action for 
all of the IMPULSE• G+/VG+ Series 2 
and Series 3 faults and IMPULSE• P3 
Series 2 faults. Therefore, you will not 
need to consult your technical manual 
when you have IMPULSE• LINK 4.1 
Basic running. The Error References 
Are communication errors that could 
occur while running IMPULSE• LINK 
4.1 Basic. 
 
 
 
 
 
Drive Faults References- IMPULSE• LINK 4.1 Basic offers built-in Help screens for the drive faults and/or alarms.  
The Help screens provide advanced diagnostics allowing you to troubleshoot your drive from your PC.  When you ‘click’ 
on the fault, the help screen provides the fault code, fault name/description, and the corrective action.     
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Or you can simply go to the Help Icon and go to the Drive Fault References for a complete list of IMPULSE• P3 Series 2, 
IMPULSE• G+/VG+ Series 2 and 3 drive faults, as shown below: 
 

 
 
COMMU NICATION ERROR REFERENCES 
The Help function provides an overview of the possible errors that could occur while running IMPULSE• LINK 4.1 Basic, 
as shown here: 
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By clicking on the type of error, you will be provided the error code with description and correction action.  
  

 
 
 
COMMUNICATION PROFILE TEST   
The Communication Profile Test Utility provides a loop 
back test to the drive to determine the status of  
communication.   This function is found in the Tools 
drop-down menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Show Error Log - This function also found in the Tools drop-down
menu, brings up an additional window showing the status of
IMPULSE• LINK 4.1 Basic. 

 


